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1 Introduction 
The Integris Behaviour module gives schools and educators an effective tool for managing Student 
Behaviour records.  This encompasses positive, negative and neutral behaviour.  Users can easily 
record behaviour records for one or more students.  All users can view and edit student records 
and record additional details for suspensions, withdrawals and other incidents. 
  
These Training Notes provide a reference during and following RM Behaviour module training.  
They cover all of the main sections of the Behaviour module.  The Behaviour Manual provides a 
comprehensive guide to the software. 
 
During training we will be working with fictitious data and all the exercises contained within this 
user guide refer to that data.  
 

1.1 Behaviour Manager Training Program 

Time Contents 

8.45 am Coffee 

9.00 am Welcome/ Housekeeping and Introductions  

Tool Bars and Sidebars 

Locating Student Details 

Entering Staff Details 

Behaviour System Preferences 

Behaviour Parameters 

Entering Behaviour Records 

10.30 am Morning Tea 

10.50 am Entering and Maintaining Behaviour Records 

Entering Suspensions 

Producing Behaviour Notifications 

Individual Behaviour Plans 

Linking Additional Documents to a Behaviour Record 

12.30 pm Lunch 

1.10 pm Links to the Lesson Attendance module 

Producing a Mail Merge letter from student details 

Export and Import of Student Records 

Behaviour Reports 

Creating a Behaviour Students at Risk Group 

2.40 pm Afternoon Tea 

3.00 pm Review Activity / Questions 
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1.2 Training Outcomes 

At the end of the training participants should be able to: 
 

 Set up Behaviour module system preferences 

 Set the paths for Individual Behaviour Plans 

 View and modify Behaviour Parameters 

 Enter, edit and delete Behaviour Records for individuals 

 Enter Behaviour Records for groups of students 

 Attach an Individual Behaviour Plan 

 Locate the Lesson Attendance Links for suspensions and withdrawals 

 Produce various Behaviour Reports including statistical information 

 Create a group 

 Generate a mail merge letter for a group of students 

 Create a simple KST (Keys Standard Template) document for use in a subsequent mail merge 
 

1.3 Getting Started 

Please read the following information and advice before using the module. 
 

1.3.1 Installation of the Behaviour Module 

Please see your school SIS Administrator if the Behaviour Module does not appear on the Integris 
sidebar. The Department of Education will provide schools with information regarding the 
installation of the software on your school network. 
 

1.3.2 The Behaviour Module and Lesson Attendance links 

When the Behaviour Module is loaded all suspension and withdrawal information will be entered 
using this module.  Lesson Attendance records will be automatically updated if a suspension or 
withdrawal is added in the Behaviour Module.  If a suspension or withdrawal needs to be changed 
or deleted this must be done in the Behaviour Module.   
 
In Lesson Attendance, the Suspension and Withdrawal codes are unavailable for selection if the 
Behaviour Module is in use.  It is not possible to edit a suspension or withdrawal record created in 
Behaviour in Lesson Attendance.  This will ensure the data for suspensions and withdrawals in 
both Lesson Attendance and Behaviour are synchronised. 
 

1.3.3 Data Entry Guidelines 

When entering additional information into the Behaviour Details and Actions Details sections type 
using sentence case.   The information that is entered here is used when producing letters and 
advices from within the module. 
 
When entering the Behaviour Details it is recommended that you use a key word first, and then 
follow this with the additional details, for example, Fighting – Graeme was involved in a fight during 
lunchtime. 
 



 
Integris Behaviour Training Notes 17-Jul-13 

Page 9 of 97 

© 2013 Civica Pty Ltd 
 

1.4 Logging on to the System 

Activity 
 

 To log on, double click on the Integris Training icon on the desktop  
 

 
 

 Type ADMIN as the User Name for use in today’s training 

 Press <Tab> to move the cursor to the Password box  

 Enter the password: keys 
 

 
 

 Click on Login or press <Enter>  
 
In schools, each user has their own user name and password, which enables access to particular 
sections of the software as determined by the school administration 
 

Note:  It is strongly recommended that you change your password once a month. 
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1.5 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 
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1.6 Using the Sidebars 

Once you have logged onto the system a blank window with a control panel (sidebar) appears 
down the right-hand side of the screen.  The General sidebar is displayed. 
 

  
  

 

The Administration module comprises of two 
sidebars.  The one displayed on the left of this page 
is the General sidebar. This provides access to the 
core functions.  From here you can enter school 
details, view and enter student and staff details and 
create groups of students and staff.  
 

It is also where schools set up their own parameters 
for the system and use the Control function to add 
new modules at a later date, and set up new users 
and passwords. 
 

By clicking on the Admin tab on the bottom of the 
sidebar a second bar is revealed over the General 
side bar.  This is the Admin sidebar which provides 
an emergency report function, enables users to 
speed edit information in students’ records, carry 
out year end procedures and produce reports. 
 

Other sidebars will be available dependent on your 
school and level of access. 
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2 Student Details 

General > Student Details 

From the General sidebar choose Student Details. The Student window opens. 
 

 
 
This is the summary window and displays the basic student data and a photograph of the student 
(where available).   

Photos are accessed by clicking on Display Student Photograph  at the bottom right-hand 
corner of the window. 
 
To view specific areas of a student’s record use the buttons on the tool bar at the top of the 
Student window: 
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Student Details Toolbar 

 
 
This drop-down menu enables the user to decide which of the rolls they wish to view: the 
Admissions Roll, Current Roll, Former Roll or the External Roll. 
 

  The Next Student and Previous Student arrows on either side of the binoculars allow 
you to scroll through the database either forward or backward in alphabetical order.  

  The Find Student tool enables users to find individual students or groups of students based 
on selected criteria.  
 

  Add a new student  

  Edit student data 

  Move a student to the Former Roll 

  Print student details  

  Send a letter 

 Send an e-mail  

 

Student Status Bar  

 
 
The Student Status Bar is designed to be visible from all panes of the window, giving users a view 
of key student indicators at a glance. 
 
The Status Bar is split into two sections, with the left-hand section reserved for more sensitive 
data.  In both sections, information on the current student is displayed using icons.  Hover the 
pointer over an icon and it will display a description of its meaning. 
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Normal Bar Sensitive Status Bar 

 Student has a flagged medical condition 

 Language Background other than 
English 

 Access restriction 

 Part-time student 

 Accepted (Admissions Roll) 

 VET Student 

 Student Notes 

 Name Change 

 Educational Support Program 

 

2.1 Locating Students’ Records 

General > Student Details 

There are five methods of searching for students in Student Details 
 

 Using the Previous Student/Next Student arrows 

 Using Quick Search 

 Using the standard Integris Find function  

 Using the Advanced Find Student Search  

 Making Siblings the Browse set 
 

2.1.1 Using the Previous Student/Next Student Arrows   

 
The Previous Student/Next Student arrows are located at the top left of the Student window.   
 
They can be used to scroll through the current browse set of students.  

Click on the Next Student arrow  to move to the next student in the browse set. Click on the 

Previous Student arrow  to move to the previous student in the browse set. 
 

2.1.2 Quick Search   

 
The Summary screen in Student Details provides a Simple Student Search facility to enable the 
user to quickly locate and load a specific student’s record. It is located at the bottom left corner of 
the Student window.   
The search operates on the currently defined browse set in the Student Details window. If no 
browse set is defined, the currently selected roll will be searched. 
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Activity 

General > Student Details 

 Place your cursor in the Search box  

 To search for a student Rebecca Bloor enter the following  

 Press <Enter> 
 
The Student Details screen for Rebecca Bloor is displayed. 
 

 

 Place your cursor in the Search box or  

 Type SMITH 

 Press <Enter> 
 
A list of all students with the surname of Smith will be displayed. 
 

 Double click on Kane Smith to view his details 
 

 

2.1.3 Find Student Function   

 
Another method of finding a student’s record is by using the standard Find Student function located 
at the top of the Student window. This function is used in other sections of Administration Manager 
and in other Integris modules.  
 
Use the Find Student tool to select students by a variety of different search criteria. Click on the 
Find Student icon and the following window appears. 
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Find a particular student by entering either a surname or Student Reference number in the 
Name/Number field.  It is not necessary to enter the whole surname.  Enter the first few characters 
and press <Enter>.  A list of students’ names matching the characters entered will be displayed.  
Double click on the appropriate name. 
 
You can find individual students or groups of students by many other criteria such as year group, 
form, teaching set, group, previous school, indigenous status, dates (including birthdays and 
students’ ages), addresses and user-defined information (UDI). 
 
The system can save any search criteria you enter - this is called a Query. A query can then be 
used at a later date to save you setting up the search again. 
 

Activity  

Find the students on K/P Form 

 Find the students in Form: K/P  
 

 
 

 Click Back 

 Clear your settings  
 

Find students using Surname and Roll Status 

 Find the student with the Surname Fuller 

 Change the Roll Status to n/s to search the Admission, Current and Former Rolls 
 

 
 



 
Integris Behaviour Training Notes 17-Jul-13 

Page 17 of 97 

© 2013 Civica Pty Ltd 
 

Find students using Health Condition 

 Select the Other tab 

 Choose Health Condition: Asthma 
 

 
 

 Click Back and clear your settings  
 

Find and print a list of students in 2012 Senior Choir: 

 Select Group Type: 2012 Music 

 In Group field select 2012 Senior Choir  
 

 
 

 Click Find button to load the Search Results 

 Click Back and clear your settings  
 

Find students by Teaching Set and save the Query 

 Click on the Teaching Sets/Cohort  tab 

 Find the students in 9ENG_3 
 

 
 

 To save the query click on the floppy disc  icon  
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 Enter an appropriate name for the search 

 

 Click Back and clear your settings  
 
To load a saved query  

 Click View the Query List   

 Highlight 9 English 3  

 Click Load 

 Click Find to locate the students matching the query 

  

Find students by Age 

 Find the students who are 10 years old TODAY 
 

 
 

 Click Back and clear your settings  
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Save a query for Indigenous girls 

 Select the Parameters tab 

 Choose Indigenous status: Indigenous 

 Chose Gender: Female 
 

  
 

 Click Find 
 

 View the results then click Back 

 Save  this query 

 Give it an appropriate name and click OK 
 

 
 

 Clear  your search criteria 

 Click View the Query List   

 Highlight Indigenous Girls 

 Click Load 

 Click Find to locate the students matching the query 
 

Note: Saving a query saves the question not the answer.  Every time the query is loaded, an 
up-to-date list of the students matching the search criteria is displayed. 
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Method 4: Advanced Find Student Search  

When searching for students the Advanced Find Student Search tool can be used to add another 
student or group of students to an existing search results list. Once the desired list of students is 
displayed the Advanced Find Student Search tool can be used to add students to the existing list. 
 

Activity: Advanced Student Search 

Find the Year 8 and 9 Boys 

 Click Find   

 On the General tab, select Year Group: 8 
 

 
 

 In the Parameters tab, select Gender: Male 
 

 
 

 Click Find or press <Enter> 
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 Click Advanced Find    to search for the additional students to add to the query 
 

 
 

 Click Add Students    to find for the Year 9 boys  
 

 
 

 Click Find, Select and Yes 

 Click on the Form column header to sort into Forms 

 Click Print    and send the report to the screen 

 Close the report 
 

 Click Select and Yes to create a combined list of the Year 8 and 9 boys 

 Click Select and Yes to create a browse set of Year 8 and 9 boys 

 Clear  the browse set by clicking on  

Note: There is currently no ability to save advanced searches. 
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Method 5: Make Siblings the Browse Set  

Once a student’s record is loaded, and any necessary changes have been made, it is easy to 
create a browse set of the student’s siblings so that the siblings’ records can be edited.  In the 
Contacts pane, right click and select Make Siblings the Browse Set. 
 

 
 
 

Activity 

General > Student Details 

 Right click in the contacts pane for Jackie Albert 
 

 
 

 Select Make Siblings the Browse Set 
 

 Indicates that a Browse Set (a subset of student records) has been created. 
 

 Click Next Student  
 
Jennifer Zolter-Albert’s records will be displayed. 
 

 Click Previous Student  to return to Jackie’s records 

 Click  and Yes to clear the browse set 
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3 Staff Details 

General > Staff Details 

Administration Manager can hold details on staff.  The staffing section of the system is accessed 
via the Staff Details icon on the General side bar.  Functionally it is very similar to the Student 
window, using many of the same icons. 
 

Activity 
 
You will now enter yourself as a staff member of West Coast DHS so that your name can be 
selected from the staff list during training. At school your details should have been entered by the 
school’s Integris administrator. 

General > Staff Details 

 Click Add   

 Enter the following information about yourself, tabbing between the fields: 
o Title 
o Surname * 
o First Name * 
o Gender 
o Date of Birth *  
o Staff Code *  (first three letters of your surname and your first initial) 
o ID Number* 
o Staff Type  

Note:  * indicates the field is mandatory 

 

UDI – WACOT Number 

WACOT is the Western Australia College of Teachers.   
 

 Click on the UDI tab to enter the details of the WACOT number.  

 Highlight WACOT Number 

 Click on the Edit UDI   

 Enter the WACOT number  
 

 
 

 Click OK to save the WACOT number  
 

 Click OK to save the Staff Details entered  
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4 Behaviour 

4.1 Behaviour Sidebar Functions 

The Behaviour features of Integris are grouped on the Behaviour sidebar. 
 

 

 
Management – Student Behaviour record data entry point.  This allows for 
one or more student records to be entered, the creation of Individual 
Behaviour Plans and notification details recorded. 
 
Reports - Statistical Management reports for monitoring purposes are 
available along with standard letters and advices that need to be sent to 
parents, school personnel and district office staff. 
 
Parameters - The Behaviour module will give users the ability to select 
and create their own codes to monitor and use in the management of 
student Behaviour Records. 
 
Utilities – The system provides the ability to import and export specified 
behaviour records between Integris schools. 

 
 

4.2 Behaviour System Preferences 

The Behaviour module stores the default settings in System Preferences.  Within the Paths tab, 
users can activate the pathway for saving Individual Behaviour Plans, the default path for the 
Individual Behaviour Plan template, mail merge source documents and merged letters.  Within the 
System Preferences General tab the default codes for Lesson Attendance can also be set. 

Note: Users will not be able to enter a behaviour record if System Preferences are not 
setup. 

 



 
Integris Behaviour Training Notes 17-Jul-13 

Page 25 of 97 

© 2013 Civica Pty Ltd 
 

  

Activity 

Behaviour > Utilities > System Preferences 

 Click on the General tab 
 

 
 

 View the default codes 

 Check Retain all new behaviour records on transfer 

 Enter Deputy Principal as the Default Position (Notice letter) 

Notes: Suspension/Exclusion Check is checked by default. Export Email Address is not 
required. 
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Behaviour > Utilities > System Preferences 

 Click on the Paths tab 
 

 
 

 View the pathways already set 

 Set the Mail Merge pathways 

Note: The Mail Merge Letters locations must be specified if mail merge is to be used. 

 Click OK to save 
 

 Close Utilities 
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4.3 Behaviour Parameters 

 
 
The Behaviour Parameters define the operation of the module.  Before starting to use the system, 
you may need to set up some of the parameters you intend to use. 
 

4.3.1 Adding Parameters 

  Click Modify parameter descriptions and add parameters, enter a code and a description.  
 

  Highlight the required parameter and click make active. 
 

  Click on the Lock function to prevent accidental editing. 
 

  To set defaults, click on the item in the list and click Toggle default condition.  
 

4.3.2 Making Parameters Inactive 

 Select it from the list: 

 Click Toggle lock status  

 Highlight the item again and select Toggle active property  

Note:  It is advised to contact your Customer Support Centre or Senior Project Officer if you 
are unsure prior to editing, deleting or adding any parameters. 
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4.3.3 Behaviour Type 

The system comes with 13 active behaviour types.  Behaviour is grouped using three categories 
Negative (-), Neutral (0) or Positive Behaviours (+). 

Note:  This parameter is locked and may not be edited by schools. 

 
 
 

Activity 

Behaviour > Parameters > Behaviour Type 

 View the list of Behaviour Types 

 To produce a report of the Behaviour Types click Print Parameters  

 Click OK to send the report to screen 

 Close the report by clicking on the cross in the top right hand corner 

 Close Behaviour Types 
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4.3.4 Behaviour Sub Type 

Schools are able to customise records to closely track targeted behaviours.  For example, a school 
may want to track types of offences against property.  They may set up Sub Types such as school, 
student and off site property damage. Behaviour Sub Type is grouped using three categories: 
Negative (-), Neutral (0) or Positive Behaviours (+). 
 

 
 

Activity 

Behaviour > Parameters > Behaviour Sub Type 

 Click Modify parameter descriptions and add parameters  

Note: To ensure Behaviour Sub Types are attached to the correct parent Behaviour Type, 
schools should check the Behaviour Type details first before adding. 

 Enter the new Behaviour Sub Type details 
 

 
 

 Click OK 
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 Highlight the newly created Sub Type 

 Click Toggle Lock Status  
 

 Repeat the above steps to create the following behaviour subtypes 
 

 
 

 Highlight the new Sub Types 
 

 Click  
 

 
 

 Click Yes  

 Close Behaviour Sub Types 
 

 

Note:  Editing options may also be accessed by right clicking on mouse.  Parameters may 
be selected and locked together. 
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4.3.5 Behaviour Actions 

The system comes with seven active negative behaviour actions, plus three not specified actions 
(positive, negative and neutral)   

Note:  Schools can add their own Behaviour Actions but must not edit or delete existing 
actions. 

 
 
  



 
Integris Behaviour Training Notes 17-Jul-13 

Page 32 of 97 

© 2013 Civica Pty Ltd 
 

 

Activity 

Behaviour > Parameters > Behaviour Actions 

Note:  If the school does not want to use all items, then unlock and deactivate those that are 
not needed.  Do not delete any from the list. 

 Click Modify parameter descriptions and add parameters  

 Type in the Category (-), press <Tab> 

 Type in the Code IBP, press <Tab> 

 Type in the Description: Individual Behaviour Plan 
 

 Enter the remaining Behaviour Actions  
 

 
 

 Click OK 
 
When Behaviour Actions are added, they automatically default to appear on the Behaviour Details 
Report and the Individual Behaviour Report.  
 

Report1 and Report2 columns refer to the Behaviour Actions that will default to appear on 
particular Behaviour Reports. Report1 Column Actions will default to appear on the 
Behaviour Details Report and the Individual Behaviour Report. 

Report2 Column Actions are limited to 7 at any one time and these are the defaults that 
appear on any other report that uses Behaviour Actions. 
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 Highlight any two of the unlocked items and right click 
 

 
 

 Click on ToggleReport1 Status 
 

 
 
 

 Click Yes 

 Click on the Locked heading to sort the Behaviour Actions by locked status 
 

  
 

 Select click on all of the unlocked items and click Toggle lock status   
 

 
 

 Click Yes 

 Close  Behaviour Actions 
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4.3.6 Notification Details 

The system comes with 17 active notification options.  When an item is inactive it does not appear 
in the list during the data entry process.  
 

 

Note:  If the school does not want to use all of these options, then unlock and deactivate 
those that are not needed.  Do not delete any from the list. 

 

Activity 

Behaviour > Parameters > Notification Details 

This school will not be using the Social Worker notification parameter so we will deactivate it. 
 

 Select Social Worker from the list 

 Click on Toggle lock status   and Yes 

 Highlight the item again and select the Toggle active property   

 Click Yes 

 Highlight the item again and click Toggle lock status   

 Close Behaviour Actions 
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4.3.7 Suspension Conditions 

The system comes with two active suspension conditions, both marked as default.  
 

 

Note:  Additional suspension conditions can be added. Defaults can also be changed; do 
not delete any from the list. 

Activity 

Behaviour > Parameters > Suspension Conditions 

 Click Modify parameter descriptions and add parameters  

 Type in the Code 003 and press <Tab> 

 Type in the Description: Commence anger management counselling 

 Click OK 
 

 Highlight the new suspension condition 

 Right click to make this new condition active 
 

 
 

 Repeat this step to lock the new Suspension Condition 

 Close Suspension Conditions 
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4.3.8 Location  

Schools are able to monitor the location of student behaviour.  This can be edited to meet the 
needs of the individual school. 
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Activity 

Behaviour > Parameters > Location  

 Click Modify parameter descriptions and add parameters   

 In Code: ASS 

 In Description: Assembly Area 

 Click OK 

 Highlight the new location 

 Click on  to lock the location option and prevent accidental editing 

 Repeat the steps above to include some of the following locations: 

Note:  A number of parameters can be added easily by tabbing to create new lines.  
Parameters can be selected and locked at the same time. 

 
 

 Highlight all of the newly created locations and click on  to lock them all 

 Click Print Parameters   

 Close the Behaviour Parameters window 
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4.4 Behaviour Management  

 
 
The Student Behaviour window is accessed by clicking on the Management icon on the Behaviour 
sidebar. It allows users to add, edit, delete and view student records.  Within this window users can 
filter what records they would like to see.  Student details such as their Year and Form are 
displayed and also any status symbols on the status bar.  
 

 
 
 

 Browse set active/Clear browse set 

 Show only student with Behaviour Records 

 Create a Mail Merge using .KST 

 Send an Email  

   Previous/ Next Student  Open General Student Details 

 Student Find   Add  Student Behaviour 

 Print Student Behaviour   Edit Student Behaviour 

 Send Letter (System Generated Letters)  Delete Behaviour entry 

 Create Individual Behaviour Plan 
  Filter by Behaviour Category.   

Use in conjunction with show all students  
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4.4.1 Behaviour History Filter Options 

 
 
The Filter option allows users to view student records for the Current Year or All years. 
The second filter option allows the user to view by a particular Behaviour Type or Action.   
These include: 
 

 Negative 

 Positive  

 Neutral 

 Detention 

 Intention to suspend 

 Loss of privilege 

 Other  

 Reprimand 

 Suspension 

 Withdrawal 
 

4.4.2 Display Details of Behaviour Records from Previous Schools 

Check the box to view behaviour records from previous schools. 
 

 
 

4.4.3 Totals to Date this School and Total to date Previous Schools 

This shows suspensions and withdrawals for the student while at the current school and from 
previous schools.  If the student had any suspensions or withdrawals recorded at their previous 
school and these have been imported into Integris, the data would be displayed here. 
 

 
 

4.4.4  Details Area 

This section of the window relates to the record that is highlighted in the Behaviour History section.  
This will display the person who reported the incident, what Action was taken and a Date 
reference. If an Appeal is lodged this will be indicated. The tabs display further information on: 
 

 Behaviour Details 

 Action Details 

 Notification Details 

 Appeal Details 

 Suspension Conditions 

 Log 

 Additional Information 

 Response 
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4.4.5 Positive Behaviour Records 

Activity 
 
Scenario: Four students from Year 7 in the primary school have received a merit certificate at the 
assembly and we would like to record this. 

Behaviour > Management 

 Click Find Student   

 Select Year Group 7 and click Find 
 

 
 

 Hold down <Ctrl> and select David Arrowsmith, Chelsea Davids, Kirsty Etheridge and 
Sebastian Gray 

 

 
 

 Click Select and Yes to create the browse set 
 

 Click Add Student Behaviour  and view the message: 
 

 
 

 Choose Yes  
 

The Group Behaviour Message Warning window can be closed when the behaviour details 
are saved. This message warns staff that for multiple Secondary students, they may have 
different Period Structures in the Timetable, so periods should be checked for each student 
record once they are saved. 
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 The students in the browse set can also be viewed by clicking on   

 Close the browse set window 
 

 Click Find Staff  next to Reported By field and select your name 

 Leave the Date as TODAY’s date  
 

 Select Merit or good behaviour award (often via assembly recognition) from the 
Behaviour drop-down menu 

 Select School Award form Action  

 Select the Location Playground. 

Note:  All suspensions and withdrawals must be retained on transfer.  All other behaviour 
incidents can be retained or not retained at the discretion of the school. 

 In Behaviour Details enter: For assisting in the rescue of an injured kangaroo on the 
school grounds. 

 In the Action Details enter: Merit Certificate to be awarded at Assembly. 
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Click OK 

 A list of all students who have had the behaviour recorded will be displayed 
 

 
 

 Close the list 

 Close the Warning message 

 Using the Next Student arrow   view the individual behaviour records  

 Click Clear Subset selection   and Click Yes to release the browse set 
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Activity 
 
We have been notified by the teacher on duty that a student, Lana Brown, had assisted a pre-
primary student who had injured herself in the playground. You would like to record the details and 
also formally notify the student’s parents. 

Behaviour > Management 

 Type  in the search field, press <Tab>  

 Click Add Student Behaviour   

 Click Find Staff   and select your name  

 Leave the Date as TODAY’s date  

 From the Behaviour drop-down menu, select Positive behaviour – other  

 From Location , select Playground 

 From the Action menu select Class Award 

 In Behaviour Details enter:  Lana assisted a pre-primary student who had hurt herself in 
the playground 

 

 
 

 In Action Details enter: Will be given a class award as recognition for this act of kindness 

 On the Notification tab, select Form Teacher and Parent 
 

 
 

 Click OK 

Note: Information entered in the Behaviour details area will be displayed on the 
correspondence to parents/guardian. 

LEAVE this WINDOW OPEN as we are now going to produce a commendation letter for the 
student. 
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4.4.6 Commendation Letter 

Activity 

Behaviour > Management 

 Click Send Letter  

 Select the Commendation Letter 2 
 

 
 

 Leave the default option of Plain Paper 

 Leave the Letter Destination as Send Letter to all marked as Family Mail Marker 

 Choose your name as the Signing Staff Member  

 Choose Mr Mark Alan  as the Senior Staff Member  

 Click Print, OK and Yes to record the letter in the Student Behaviour Log 

 View then close the letter 

 Click on the Log tab to view the record of the letter being created 
 
 

 

Note:  Only customised letters can be printed from the Behaviour Log once the letter has 
been produced through Behaviour > Management. 
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Integris Behaviour Training Notes 17-Jul-13 

Page 46 of 97 

© 2013 Civica Pty Ltd 
 

 

4.4.7 Modifying Behaviour Letters  

Activity 
 
Scenario: If a modification needs to be made to the body of any of the behaviour letters, this can be 
achieved by saving in RTF (Rich Text Format) and opening in Word to edit. 

Behaviour > Management 

 Select the Send Letter function on the top tool bar  

 Select the Commendation Letter 2 

 Click OK 

 The print options window will be displayed: 
 

 
 

 Leave the default option of Plain Paper 

 Leave the Letter Destination as Send Letter to all marked as Family Mail Marker 

 Choose your as the Signing Staff Member  

 Choose Mr Mark Alan  as the Senior Staff Member  

 Click Print, 

 Select RTF as the Report Destination 

 Click OK 

 Choose Desktop as the save location and type Commendation as the file name 

 Click Save 

 Select No to recording the letter in Student Log 
 

 Minimise Integris and open the commendation letter by double clicking on it 

 It will now be available in Word to edit. Close the letter and return to the Integris screen by 
clicking on West Coast District High on the bottom toolbar 

 
Later in training we will look at creating our own customised letters for use in a subsequent mail 
merge. 
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4.4.8 Neutral Behaviours 

Activity 
 
Scenario: The students in Year 6 participated in the Bully Buster program and you would like to 
record this information.  

Behaviour > Management 

 Click Find  

 Select Year Group 6 and click Find 

 Click Select and Yes to create the browse set 

 Click Add Student Behaviour   
 

 
 

 Click Yes  

 Click Find Staff   and select your name from the list 

 Leave the Date as TODAY’s date  

 From the Behaviour drop-down menu select Neutral Behaviour 

 From the Action drop down menu select Not Specified 

 In Behaviour Details enter Participated in the Bully Busters Program 
 

 
 

 From the Location drop down menu select Assembly Area 

 Click OK 
 
A list of all students who have had this behaviour recorded will be displayed. 
 

 Close the list 
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 Click Next Student  to view the behaviour records for the subset of students 

 Click Clear Subset Selection  to release the browse set 
 

 
 

4.4.9 Detention 

Activity:  
 
Scenario: Two Year 10 students, Ben Anderson and Gavin Parsons were involved in a fight during 
lunch in the car park area  
 

 Find Ben Anderson and Gavin Parsons  

 Click Add Student Behaviour   

 Click Yes to add the behaviour record for all students in the Browse Set 

 Click Find Staff   and select your name from the list 

 Leave the Date as TODAY’s date  

 From the Behaviour drop-down menu select Physical assault or intimidation of other 
students 

 From Location select Car Park Area  

 From Action select Detention 
 

 In Behaviour Details, enter Student was involved in a fight during the lunch time break. It 
was caused by a student taking another student’s hat.  

 

 
 

 In Action Details enter Student will apologise for taking the other student’s hat and to the 
duty teacher for his bad language. 

 

 
 

 In Notification Details check Deputy Principal, Form Teacher and Parent 
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 On the Additional tab check N2 and N4 
 

 
 

 Click OK  

 Close the Warning message 
 

 
 

Editing Behaviour Records 

Activity 
 
Gavin Parson’s Record needs to be edited because he did not verbally abuse a staff member. We 
will edit the Action Details 
 

 Click Next Student  

 Click Edit Student Behaviour  

 Select the Action Details tab 

 Delete the action details for Gavin Parsons.  

 Select the Additional tab and uncheck N2 

 Click OK 

 Click Clear Subset selection   to release the browse set 
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4.4.10 Intention to Suspend 

Activity 
 
A Year 9 student Simone Aspinall has written graffiti in the girl’s toilets using a black permanent 
marker. She became quite agitated when approached by staff and swore at the duty teacher.  An 
intention to suspend will be recorded and a Suspension Considered letter will be generated. 

Behaviour > Management 

 Locate the record for Simone Aspinall 

 Click Add Student Behaviour    

 Click Find Staff  and select your name from the list 

 Leave the Date as TODAY  

 From the Behaviour drop-down menu select Wilful offence against property  -Damage 
School Property 

 From Location select Toilets 

 From Action drop select Intention to suspend 

Note: The “From” and “Until” dates do not need to be entered as this is only an Intention to 
Suspend. 

 In Behaviour Details enter Simone was found at recess writing graffiti on the walls of the 
girl's toilet using a permanent marker. When approached by the duty teacher, she used 
inappropriate language. 

 

 
 

 In Action Details enter Simone will assist in the removal of the graffiti and write a letter of 
apology to the duty teacher for the bad language 

 

 
 

 In Notification Details check Deputy Principal and Parent  
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 In Additional check N2  
 

 
 

 Click OK  
 
LEAVE this WINDOW OPEN as we are now going to produce a Suspension Considered Letter. 
 

 
  



 
Integris Behaviour Training Notes 17-Jul-13 

Page 52 of 97 

© 2013 Civica Pty Ltd 
 

 

4.4.11 Suspension Considered Letter 

Activity 

Behaviour > Management 

 Click Send Letter  

 Select Suspension Considered and click OK 

 Leave the default option of Plain Paper 

 Leave Send letter to all marked as Family Mail Marker 

 Leave the Referring Staff Member as the Principal 

 Choose Mark Alan  as the Contact Staff Member and enter his Position as Deputy Principal  

 Enter a date two days in advance of today’s date (this provides a cut off date for the 
parent/guardian to respond) 

 The Letter Date can be left as today’s date 
 

 
 

 Click Print  

 Select RTF and click OK  

 Save the letter in the following path C:\keys\INTEGRIS\BEHAVIOUR 
 

 In File Name type AspinallSddmmyy  

 Make sure the Save as type is RTF Files (*.rtf) 
 

 
 

 Click Save 
 



 
Integris Behaviour Training Notes 17-Jul-13 

Page 53 of 97 

© 2013 Civica Pty Ltd 
 

 

 
 

 Click Yes  

Note: The Document has been saved to the Behaviour Folder using the paths set up in 
System Preferences. 

 Navigate to C:\keys\INTEGRIS\BEHAVIOUR\AspinallSddmmyy.rtf to view the intention to 
suspend letter for Simone. RTF files may need to be edited or formatted once opened. 

 

 Close the letter and view the Log tab 
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4.4.12 Emailing a Behaviour Advice 

Activity 
 
Scenario: Mrs Aspinall has requested that a copy of the Intention to Suspend Notice be emailed to 
her at work.   

Behaviour > Management 

 Click View Maintain Student Details   

 Double click on Ms Maria Aspinall’s entry in the Contacts area  

 View the email address then close Contact Information and Student Details 
 

 Click Send an email  

 Click on  

 Highlight the email address maspinall@sw.com.au and then click back.  

 In Subject,  type Intention to Suspend 

 Click on the Message tab and type: 
 
Dear Mrs Aspinall, Further to our recent conversation regarding Simone, please find 
attached a copy of the Intention to Suspend Notice. Yours faithfully, Mr C Best 
 

 
 

 Click the Attached Files tab 

 Click on  and navigate to C:\keys\INTEGRIS\BEHAVIOUR\AspinallSddmmyy.rtf 
 

mailto:maspinall@sw.com.au
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 Click Send 
 
In training only you will see the following message because you are not connected to the internet. 
 

 
 

Note:  Email addresses recorded in Student Details are available in the Behaviour Module 
email address book.  This can be accessed by clicking on the open book icon on the To 
button. Email addresses for the current student will be shown.  
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4.4.13 Suspension 

Activity 
 
A group of secondary students have been caught smoking marijuana near the Bike Racks before 
school and are going to receive an immediate suspension for two days as it is a serious breach.  
Students were also found to have damaged play equipment through misuse. 

Behaviour > Management 

 Click Find Student  

 Select Form 10.1 and click Find 

 Select the first four students  
 

 
 

 Click Select and Yes 

 Click Add Student Behaviour    
 

 
 

 Click Yes  

 To view the students names for whom the behaviour will be added click View students 
in browse set    

 Close the Current Browse Set window  
 

 Click Find Staff   and select your name from the list 

 Leave the Date as TODAY’s date  

 From the Behaviour drop-down menu select Illegal Substance Offence-Possession 
Cannabis 

 From Location select Bicycle Racks 

 From Action select Suspended 
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 Click Yes  

 In From enter TODAY’S date – Period 4 

 In Until enter TOMORROW – Period 5 

Notes:  On Thursday, West Coast District High School has an early finish.  In the Period 
Structure lunch is taken in the slot which is labelled period 4 and period 4 occurs during the 
slot labelled lunch. 

Retain on transfer  is selected by default and will allow the record to be 
exported if a student transfers to another school 

For WA schools all suspensions must be marked Retain on transfer. 

 In Behaviour Details, type Student was found with three others smoking marijuana near 
the Bicycle Racks. 

 In Action Details enter Student waiting in Deputy’s office awaiting police attention and 
parent notification. 

 In Notification Details check Deputy Principal, Parent, Police and Principal 
 

 
 

 In Additional check N6 and N8-1a  

 Click on the Appeal Details tab.  
 
This tab would remain inactive unless the Appeal lodged against action checkbox had been 
selected.  
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Note: We will not be entering an appeal for this suspension as it is an immediate 
suspension. If an appeal was lodged the Date of the Appeal would be entered in the Date 
field. The Status of the appeal options would be selected from the Status drop down list as 
shown below. 

 
 

 Click OK 

 Check the following items and click OK 
 

 
 

 View the list of all students who have had the behaviour incident added to their record then 
Close  

 Close the Multiple Student Warning message 
 

 Click Next Student   to view the individual behaviour records 
 
LEAVE this WINDOW OPEN as we are now going to produce a Suspension Notice for Ben 
Anderson. 
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4.4.14 Suspension Notice 

Activity 

Behaviour > Management 

 Return to Ben Anderson’s behaviour record 

 Select Send Letter   

 Select Suspension Notice and click OK 

 Enter the details as shown below 
 

 
 

 Leave the Letter Date as TODAY  

 Print  the report to the Screen  

 Click Yes to send the details of the letter to the student’s behaviour log 

 Select the Log tab to view the record of the Notice to Suspend  

Note: This process would need to be repeated for the other in the browse set students 

LEAVE this WINDOW OPEN as we are now going to produce an Internal School Advice. 
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4.4.15 Internal School Advice 

Activity 
 
The Internal School Advice is used to advise other relevant staff of the incident that has occurred 
and includes a distribution check area on the top section of the form. 

Behaviour > Management  

 Select Ben Anderson’s behaviour record 

 Click Send Letter  

 Select Internal School Advice and click OK  
 

 Click Find Staff  and select Mark Alan as the Referring Staff Member 

 Enter the date you wish to have printed on the Internal School Notification 
 

 
 

 Click Print and OK to send the report to the Screen 

 Click Yes to record the letter in the student behaviour log 

Note: This process would be repeated to produce Internal School Advice for the other 
students in the browse set. 

 Close the Student Behaviour window 
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4.4.16 Suspension Notice for District Office 

In WA schools the Suspension Notice for District Office is not required 
unless requested, as suspensions are automatically extracted from 

Integris. 
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4.4.17 Further Suspension 

Activity 
 
Ben Anderson has recently been suspended for smoking marijuana and for damaging the school 
playground.  On returning to school he assaulted and verbally abused a student whom he believed 
had informed the staff of the incident. 

Behaviour > Management 

 Find the student Ben Anderson 

 Click Add Student Behaviour   

 Click Find Staff   and select your name 

 Enter the date as the day Ben returned to school following the last suspension  

 From the Behaviour drop-down menu select Physical Assault or Intimidation of other 
Students 

 From Location  select Toilets 

 From Action select Suspended 

 Click Yes to the two default conditions and check Commence anger management 
counselling 

 In From Date  enter the date of the incident, Period H 

 In the To Date - enter the date four days after the incident, the last period of the day 
 

 Retain on transfer will be checked by default. This allows the record to be exported if a 
student transfers to another school 

Note: For WA schools all suspensions must be marked Retain on transfer. 

 In Behaviour Details enter Physical assault - punched, kicked and verbally abused a 
student whom he believed was the informant on his marijuana smoking 

 In Action enter Waiting in Deputy’s office for parent pick up 

 In Notification check Form Teacher , Parent, Principal and Year Coordinator  

 On the Response tab, check Parent Response tick box and type Parents will pick the 
student up this morning and attend a meeting on Monday ddmmyy 

 Click OK 

 Complete the Suspension Check and click OK 
 

 
 

Note:  For this Training Activity only we will not be producing the required notifications. 
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4.4.18 Withdrawal 

Activity  
 
A Year 9 student, Tracey Bennett, has been sent to the Deputy’s office for being disruptive in an 
Art class and refusing to follow teacher’s instructions. 

Behaviour > Management 

 Locate Tracey Bennett’s records 

 Click Add Student Behaviour   

 Click Find staff  and select your name  

 Enter the date of the incident as TODAY’S date 

 From the Behaviour drop down menu select Violation of school Code of Conduct … 

 From Action select Withdrawal  

 Enter the From and Until dates as TODAY  

 Enter Period 5 as the first and last withdrawal period  
 

Note: If today is a Thursday, mark the withdrawal as Period 4 as this is the last period of 
instruction on Thursdays for West Coast District High. 

 

 From Location select Classroom 
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 Enter Behaviour Details: Tracey was refusing to follow the teacher's instructions and 
was withdrawn from class 

 In Action Details enter: Tracey has been withdrawn to the deputy's office to complete set 
tasks for the last period of the day. 

 In Notification Details  check Parent and Year Coordinator 

 Click OK 

Note:  For secondary schools which have a home period this will be counted as one of the 
periods in the lesson attendance module when calculating lesson attendance data. See 
screen shot below for an example of the resulting lesson attendance data taken from Day 
View.  

 

Note:  For Primary school Period T1 would mark the AM cell and Period t2 would mark the 
PM cell in lesson attendance. 

LEAVE this WINDOW OPEN as we are now going to produce a Notice of Behaviour Incident letter 
for the student. 
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4.4.19 Notice of Behaviour Incident 

Activity 

Behaviour > Management  

 Click Send Letter   

 Select Notice of Behaviour Incident and click OK 

 Select the following options 
 

 
 

 Select Mark Alan as the Requesting Staff Member  

 Leave the Letter Date as TODAY 

 Print the letter to the Screen 

 Select Yes  to record the letter in the student log 

 Click on the Log tab to view a record of the letter being produced 
 

 Click Edit record  and select the Response tab   

 Check Parent Response   and enter a comment Parent returned notice of 
withdrawal. Interview arranged. Parent requested School Psychologist attend 

 Click OK 
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4.5 Searching, Editing and Deleting Behaviour Records 

4.5.1 Searching Student Behaviour Records 

Activity 

Behaviour > Management 

 Click Show Only Students with Behaviour Records   

 Browse  through the student records 
 
We will now refine our search to find all Year 10 students who have a behaviour record. 
 

 Click Find Student   

 Select Year Group 10 

 Click Find, Select and Yes  

 Browse  through the year 10 student records that display a behaviour incident 

 Click Clear Subset Selection   
 

Behaviour > Management 

 From the top tool bar drop-down menu select Neutral 
 

 
 

 Browse through the student records  
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4.5.2 Editing Behaviour Records  

Activity 

Behaviour > Management  

 Locate Simone Aspinall’s  record  

 Click Edit   

 Select the Response tab and check the Parent Response box  

 Enter the following parent response details: Simone's mum has discussed the Intention to 
suspend with Mr Mark Alan and because of work commitments and Simone's previous 
good record, Simone will receive 3 periods of lunchtime detention. 

 Change the Intention to suspend action to detention  

 Click OK to update the record 
 

 

 Locate Sally Angus 

 Filter to show Behaviour History records for All years    

 Highlight the record for 2009 
 

 
 

 Click Edit  and Yes  

 Enter Behaviour Details to read State winner of the Tim Winton writing competition 

 Click OK to save 
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4.5.3 Deleting Behaviour Records 

Activity 
 
Scenario: Rueben Baker was absent and did not attend the Bully Busters program we entered 
earlier, so the school officer wishes to remove the record. 

Behaviour > Management 

 Locate Rueben Baker and highlight the behaviour record  
 

 
 

 Click Delete Student Behaviour   
 

 
 

 Select Yes to delete 
 

 

4.5.4 Printing Behaviour Records 

Activity 

Behaviour > Management 

 Locate Ben Anderson’s  record 

 Highlight one or more of his behaviour records 

 Click Print Student Behaviour    

 Click OK to send the report to the screen 
 

Note: Users have the option of selecting and printing selected individual or multiple records 
if more than one behaviour record exists. 
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5 Individual Behaviour Plans 
In some instances users may choose to create an Individual Behaviour Plan.  A Behaviour Plan 
can be created in association with a Behaviour record or independently.  When initiating the plan 
users are launched into a Word template.  This template can be individualised by the user in Word 
and linked to Integris.  Users must set up a default path to direct the storage of the document. 
 

5.1.1 Creating an Individual Behaviour Plan  

 

Activity 
 
Scenario: A year 8 student, Aaron Atkins has been bullying another student at the Bus stop. An 
Individual Behaviour Plan will be linked to his behaviour record. 

Behaviour > Management 

 Locate Aaron Atkins record 

 Click Add Student Behaviour   

 Click Find staff  and select Joseph Brigg as the reporting staff member 

 Enter the Date as TODAY 

 From the Behaviour drop-down menu select Verbal abuse or harassment of students 

 Enter the  Location as School Bus Area  

 In Action select Individual Behaviour Plan 

 Enter the Behaviour Details: Bullying - Continually taunting another student about his 
hair colour 

 

 
 

 Enter the Action Details: As Aaron is continually taunting David Smith an IBP (Individual 
Behaviour Plan has been put into place 

 

 
 In Notification Details check Behaviour Management Coordinator, Deputy Principal, 

Parent and School Psychologist 

 Click OK 
 
LEAVE this WINDOW OPEN  as we are now going to produce an Individual Behaviour Plan for the 
student 
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 Click Plan  and Create New Plan    

 Leave TODAY’S date as the Date Created 

 In Document Name enter Atkins, Aaron 
 

 

Note: The default Document Path is displayed.  At school this will be 
K:\keys\INTEGRIS\BEHAVIOUR. 

 Enter a Review Date one month from TODAY 

 Click OK 
 

 Highlight the path to the plan and click  

 The document will open and be available from the bottom tool bar 

 Add the following actions 
o Must report to the school bus duty teacher immediately after school 
o Must not make any comments to David Smith 
o Will attend weekly meeting with School Psychologist 

 Close the document and click Yes to save changes 
 

 
Other options available in the Individual Behaviour Plan window include: 
 

 
Print Plan sends the selected plan directly to the printer 

  
Edit Plan enables the user to edit the review date etc 

 
Link Plan enables additional documents or existing Individual Behaviour 
Plans to be linked to the student record.  

 
Edit Plan Details will launch the selected document and enable the user to 
edit the details 

 
Delete Plan enables the user the option to delete the plan  
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5.1.2 Linking Behaviour Records to Other Documents 

In this example we are going to link the sheet outlining the health benefits of quitting smoking. 
Schools could use this option to link existing Individual Behaviour Plans created previously or any 
other documents.  
 

Activity 
 
A Year 10 student, Rebecca Bloor has been smoking at the bicycle racks.  A sheet outlining the 
health benefits of quitting smoking will be provided to the student and linked to the behaviour 
record. 

Behaviour > Management 

 Locate Rebecca Bloor’s record 

 Click Add Student Behaviour    

 Click Find Staff  and select Elaine Abbott  

 Leave the Date as TODAY 

 From the Behaviour drop-down menu select: Substance misuse – Tobacco Misuse  

 In Location select Bicycle racks 

 In Action select Reprimand 

 On the Behaviour Details tab enter Smoking at the bicycle racks 

 In Action Details enter Notification sent to parents and health sheet provided 

 In Notification Details check Parent and Year Coordinator 

 In Response check Parent Response  and enter Parents have agreed to speak to Rebecca 
about smoking 

 Click OK  
 
LEAVE this WINDOW OPEN as we are now going to produce a link to the Health sheet provided to 
the student. 
 

 

 Click Plan  and Link Plan   

 Enter TODAY’S date as the Date Created 

 Click on the magnifying glass, navigate to C:\keys\INTEGRIS\BEHAVIOUR\Health Benefits of 
Quitting 
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 Click OK 

 Click Edit Plan Details   to view the linked document 

 Close the document and the Individual Behaviour Plan window 
 

 

5.1.3 Modifying the IBP Template 

The sample template supplied with the software can be modified to suit the schools own 
requirements. 
 

Activity 
 

 Open Word  

 Open C:\keys\INTEGRIS\Behaviour\IBP_Template 

 Change the RM Secondary School to your school name 

 Save  and close 

 Click on West Coast District High at the bottom of your screen to return to Integris. 
 

Behaviour > Management 

 Use Rebecca Bloor 

 Click Plan  

 Click Create Plan  

 Enter a name for the document and the Review Date  

 Click OK 

 From there you can enter details on to the document for that student  

 Close the plan and Behaviour Management  
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6 Links to Lesson Attendance 

Activity 

Lesson Attendance > Week View 

 Select Form 10.1  

 Enter the date for the Monday of this week 

 View the Lesson Attendance suspension records that were created earlier in Behaviour  
 

 
 

 Use Select Date  to select the last Monday of the current term 

Attendance Term Dates for students for 2013: 

Term 1-  Monday 4 February to Friday 19 April 
Term 2 - Monday 6 May to Friday 5 July 
Term 3 - Monday 22 July to Friday 27 September 
Term 4 - Monday 14 October to Thursday 19 December 
 

 
 

 Notice the daily records have not been created for the last day of term 

Note: For training purposes only we have created our daily records for the term in advance.  
At school this will not be the case.  Attendance codes Z and W are deactivated in the list of 
attendance codes in Lesson Attendance as these are managed by the Behaviour module.  

 Exit Week View  
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A Year 9 student, William Green has been suspended for swearing at a teacher. He also pushed 
over a table, breaking some beakers. The Daily Records have not been created.  For the purposes 
of this exercise we will create a future absence.    

Behaviour > Management 

 Locate William Green 

 Click Add Student Behaviour   

 Select Harris Barclay as the Reported By teacher   

 Enter the incident Date as the second last day of current term  

 Select the Behaviour Verbal abuse or harassment of staff 

 Enter the Location as Science Lab and the Action, Suspended  

 Click No as you do not wish to use the default Suspension conditions  

 Check Specific permission must be gained to enter the school grounds 

 In From, enter the date of the suspension as the last day of current term  
 

 
 

 Click OK 

 Select Period 5 as the Until Period 

 Record the details of the incident in Behaviour Details  

 Record the action taken in Action  

 Check Deputy Principal, Principal, Form Teacher and Parent on the Notification 

 Check N5a on Additional 
 

 Click OK to Save 
 

 Check Immediate suspension for serious breach and Letter of notification to parents 

 Click OK 
 

 
 

 Click OK 

 Close the Student Behaviour window 
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Lesson Attendance > Absences > Future Absences 

 

 Click on Apply Filter  and type in Green next to Student Name 

 Click on Apply Filter 

 View the details of the future absence for William Green.  
 

 
 
When Daily Records are created for this day, the suspension will be displayed in William Green’s 
Lesson Attendance records 
 

 Close Future Absences  
 

Lesson Attendance > Parameters > Create Daily Records 

 Enter the date for the last day of the current term  
 

 
 

 Click Create  and Yes  
 
The daily records will be created for each year group for one day 
 

 Click Exit and close Parameters 
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Lesson Attendance > Week View 

 Enter the date for the Monday of the last week of current term  

 Select Student Find  

 Enter GRE,W in Student / Ref No and <Enter> 
 

 
 

 View the data that has now been updated with the Future Absences created by Behaviour 
 

 
 

 Exit Week View 
 

Lesson Attendance > Day View 

 Leave the date as TODAY 

 Select Student Find 

 Type BEN,T and <Enter> 

 View Tracey Bennett’s attendance withdrawal record created earlier 
 

 
 

 Exit Day View 
 

Behaviour > Management 

 Locate Tracey Bennett’s records 

 Highlight her behaviour record, click Delete  and Yes  
 

Lesson Attendance > Day View 

 Locate Tracey Bennett’s records 

 View the updated attendance data 

 Exit Day View 
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7 Mail Merge  

7.1 Producing a .KST Template 

If schools wish, they can create their own Customised Letters using kst templates. These letters 
can then be Mail Merged from the Behaviour Module. 
 

Activity 
 
The students involved in smoking marijuana are being invited to attend a Drug Awareness Program 
with their parents. This activity is being coordinated by the School Nurse. We are going to create a 
letter inviting them to attend using the mail merge function within the Behaviour module. 
 
We will begin by adding a Group Type called 2012 Behaviour to the Groups Parameter. We will 
then create a Group called Substance Awareness into which we will place the students 

General > Parameters > Group Types 

 Right click and choose  

 Type 2013 Behaviour 

 Click OK and Close 
 

General > Groups 

 From the Group Type drop down menu select the 2013 Behaviour  

 Click Add Group   

 In Group Description type Substance Awareness and check the Parent Consent box 
 

 
 

 Click OK 

 Click Add Members  on the right hand side 

 Find Form 10.1 

 Select the first four students 
 

 
 

 Click Print Selected Groups  
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Now a group has been created, the Mail Merge function in Integris can be used. The Mail Merge 
fields available in Behaviour Manager can be accessed from a .kst document on your K: Drive at 
school.  
 

 Navigate to C:\keys\INTEGRIS\MMTPL\LETTERS\Behaviour 

 Double click on the BEHAVIOUR.KST file 

Note: This document lists all student fields from the Behaviour module that can be used 
when creating a mail merge letter.  Fields can be copied and pasted into a letter template. 

 Open a new blank document in Word  

 Insert the school logo by selecting Insert > Picture > From File and navigating to 
C:\keys\INTEGRIS\CM\Images\Admin Logo  

 Insert the date by selecting Insert > Date and Time 

 Create the letter template on the following page by copying and pasting the relevant fields from 
BEHAVIOUR.KST  

 

 

The Mail Merge Fields may be typed in but each one must include the <> symbols. All fields 
are case and space sensitive so must appear exactly as in the Behaviour.kst document. 

 

 If any of the merge fields are not in the same font as the rest of the letter then highlight all of 
the text in your letter and change the font 

 Go to File > Save As 

 Navigate to C:\keys\INTEGRIS\MMTPL\Letters\Behaviour 

 Enter the file name “Invitation to Drug Awareness Program.kst”  

NOTE:The file name MUST include the quotation marks and.kst. 

 Close the Word document 

 Close the .kst documents 
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7.1.1 Sample .KST Template 
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Behaviour > Management 

 Click Find  

 From Group Type select 2013 Behaviour 

 From the Group select Substance Awareness 
 

 
 

 Click Find, Select and Yes  

 Click Create Customised Letter  

 Check Send to all Contacts marked as Family Mail Marker 
 

 
 

 Click OK 

 Open the Behaviour folder and double click on the Invitation to Drug Program.kst 
 

 
 

 Click OK 
 

 
 

 Click Yes to save the letter to the Student’s Behaviour log 
 
The letters will merge with the student information. The merged letters will be displayed on the 
taskbar at the bottom of the screen. 
 

 View, then close the merged letters 

 Select the Log tab 

 Highlight the hyperlink for the letter and double click  

Note: Only Customised Letters (Those created as .kst mail merge documents) can be 
reopened from the student’s Log screen. The merged documents can be also accessed 
through C:KEYS\INTEGRIS\MMTPL\Letters\Invitation to Drug Program ddmmyytime.doc 

 View merged letters and close 
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7.2 Importing and Exporting Behaviour Records 

7.2.1  Export of the Student Behaviour Records using School to School Export 

Placing a tick in the box  will allow the record to be exported if a student transfers to 
another school and the school administrator initiates a school to school export.  

IMPORTANT 

For WA schools, all suspensions must be marked Retain on transfer. 

 

7.2.2  Import of Student Records using the School to School Import 

When a school imports a student record from another school, all behaviour records the school has 
marked as Retain on transfer will be imported into the behaviour module. 
 

7.2.3  Import of Behaviour Data from an External Source 

Behaviour > Utilities > Import Behaviour Data from an external system 

This utility enables schools to import behaviour data from another system in a csv format.  To be 
able to import the data some requirements need to be in place. 
 

 The import file is a comma separated text file (csv). 

 The Behaviour codes and Action codes in the import file must match codes defined in the 
Behaviour Category and Negative Action parameters. 

 The user will need to place the csv file in the Inbox within Integris. 
 

Available Fields for Import 

 Student Ref (SIS Ref No.) 

 Student Surname 

 Student First Name 

 Date Recorded 

 Reported by (first name surname) 

 Behaviour Code  (SIS code) 

 Action Code  (SIS code) 

 Behaviour Details text 

 Action Details text 

 Suspension Actions:  
o From Date 
o To Date 
o No. Days Suspended 

 
  



 
Integris Behaviour Training Notes 17-Jul-13 

Page 85 of 97 

© 2013 Civica Pty Ltd 
 

8 Behaviour Reports 
The Behaviour Reports consist of a number of standard reports that schools can produce to view 
either individual behaviour records or statistical comparisons. 

8.1.1 Behaviour Details Report 

The intention of this report is to provide the stored behaviour incident details and actions for a 
selected student(s) in a hard copy report. 
 

Activity  

Behaviour > Reports > Management Reports > Behaviour Details Report 

 Uncheck   

 On the Options tab enter the Incident Reported Dates as the current term  

 Drag Year, Reported by and Location into the Sort Field column 
 

 
 

 Select the Student Selection tab  

 From the Select Students by menu, select Year Group  

 Click Select All  
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View the Behaviour Types/Actions tab and add Class Award  
 

 
 

 Print the report to the screen 

 View and close the report 
 
If you wish to filter options to report only on certain Behaviour Types/Actions, select those that are 
required and reprint the report. 
 

Note: Actions marked as ‘YES’ in the Report1 column in Behaviour>Parameters>Behaviour 
Actions will display as selected on this report. To remove them simply deselect them before 
printing the report.  
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8.1.2 Individual Behaviour Report 

The intention of this report is to provide full details of particular or selected behaviour incidents for 
a student(s) on a one page per incident basis. 
 

Activity 

Behaviour > Reports > Management Reports > Individual Behaviour Report 

 Click New Query and Find the Year 9 students 

 Enter the date range for the current term 

 Check Student Photo 
 

 
 

 Print the report to the screen 
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8.1.3 Student Suspensions Summary 

The intention of this report is to provide details of suspensions for selected student(s) from a 
historical perspective. 
 

Activity  

Behaviour > Reports > Management Reports > Student Suspensions Summary 

 On the Options tab enter the Date range for the current term 

 Double Click Year to add to the Sort Fields  

 Select Date from Secondary Sort  
 

 
 

 On the Student Selection tab Select Students by Year Group   

 Click Select All   

 Leave all Behaviour Types selected 

 Print the report to the screen 
 

 View Behaviour Type and Teacher as Secondary Sort options 
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8.1.4 Behaviours - Statistical Overview 

The intention of this report is to provide a comprehensive statistical overview of the behaviour 
details held for selected students and groups for a given date range. 
 

Activity 

Behaviour > Reports > Management Reports > Behaviours - Statistical Overview 

 On the Options tab enter the date range for the current term 

 Check Include the code key 
 

 
 

 On the Select Student tab select Year Group 10 

 Print the report to the screen 
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8.1.5 Suspensions - Statistical Overview  

This report is based solely on behaviours that have resulted in confirmed suspension actions 
 

Activity 

Behaviour > Reports > Management Reports > Suspensions - Statistical Overview 

 On the Options tab enter the date range for the current term 

 Check Include Totals and Averages for the selected students 

 Check Include the code key 
 

 
 

 On the Student Selection tab, select Year Group 10 

 Print the report to the screen 
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8.1.6 School Summary – Number of Suspensions 

This report is based solely on behaviours that have resulted in confirmed suspension actions.  It 
will not contain any records for the action of Intention to suspend. 
 

Activity 

Behaviour > Reports > Management Reports > School Summary – Number of Suspensions 

 Leave the Selection as All students and Current Roll 

 Enter the date range for the current term 
 

 
 

 Print the report to the screen 
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8.1.7 School Summary – Number of Times Suspended 

This report provides a school suspension statistical overview with a year and gender breakdown. 
 

Activity 

Behaviour > Reports > Management Reports > School Summary – Number of Times 
Suspended 

 Enter the Incident Reported Date range for the current term 
 

 
 

 Print the report to the screen 
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8.1.8 Suspension Status 

This report provides the students who are currently on suspension for a given date. 
 

Activity 

Behaviour > Reports > Management Reports > Suspension Status 

 

 
 

 Enter the Date of Suspension status information as TODAY 

 Print the report to the screen 

 View and close the report  
 
This Report can be copied and pasted by dragging your mouse over the document and pressing 
Ctrl C on your keyboard, opening a Word document and pressing Ctrl V to paste. 
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8.1.9 Detention Statistical Overview 

This report provides a school suspension statistical overview with a year and gender breakdown. 
 

Activity:  

Behaviour > Reports > Management Reports > Detention Statistical Overview 

 Enter the Incident Reported Date range for the current term 
 

 On the Student Selection tab, select Form  

 Click Select All   
 

 
 

 Print the report to the screen 
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9 Review 

Activity  

Write the steps/path you would take to: 

1. Set up the System Preferences used by the Behaviour module. 
 
 
 
 
 
 
2. Produce an Individual Behaviour Report. (There are two answers.) 
 
 
 
 
 
 
3. Record a negative behaviour and the action as Intention to suspend for Ben Anderson. 
 
 
 
 
 
 
4. Create an Intention to Suspend letter to be sent home for Ben Anderson. 
 
 
 
 
 
 
5. Attach a Behaviour Management Plan to Ben Anderson’s records and enter some information. 
 
 
 
 
 
 
 

  



 
Integris Behaviour Training Notes 17-Jul-13 

Page 96 of 97 

© 2013 Civica Pty Ltd 
 

Index 

A 

Advanced Find Student Search ............................................ 20 

B 

Behaviour Details Report ..................................................... 85 
Behaviour Sidebar ............................................................... 24 
Behaviours - Statistical Overview ........................................ 89 

C 

Change User ........................................................................ 10 
Commendation Letter ......................................................... 44 

D 

Data Entry Guidelines ............................................................ 8 
Deleting Behaviour Records ................................................ 71 
Detention............................................................................. 48 
Detention Statistical Overview ............................................ 94 

E 

Editing Behaviour Records ............................................. 49, 70 
Emailing a Behaviour Advice................................................ 55 

F 

File Menu ............................................................................. 10 
Find Student Function ......................................................... 15 
Future Absences .................................................................. 78 

G 

Group Types ........................................................................ 80 
Groups ................................................................................. 80 

I 

IBP Template ....................................................................... 75 
Import .................................................................................. 84 
Individual Behaviour Plans .................................................. 72 
Individual Behaviour Report ................................................ 87 
Installation ............................................................................. 8 
Intention to Suspend ........................................................... 50 
Internal School Advice ......................................................... 62 

K 

KST Template ....................................................................... 80 

L 

Lesson Attendance links ........................................................ 8 
Linking Behaviour Records to Other Documents ................. 74 

Links to Lesson Attendance..................................................76 
Locating Students’ Records ..................................................14 
Lock Terminal ......................................................................10 
Logging on ..............................................................................9 

M 

Mail Merge ...........................................................................80 
Maintaining parameters ......................................................27 
Make Siblings the Browse Set ..............................................22 
Modifying Letters .................................................................46 

N 

Neutral Behaviours ..............................................................47 

P 

Parameters 
maintaining .....................................................................27 

Password .............................................................................10 
Positive Behaviour Records ..................................................40 
Printing Behaviour Records ..................................................71 

R 

Report Destination ..............................................................10 

S 

School Summary – Number of Suspensions .........................91 
School to School Export .......................................................84 
Side Bars ..............................................................................11 
Simple Student Search .........................................................14 
Staff Details ..........................................................................23 
Statistical Overview........................................................ 89, 90 
Student Details .....................................................................12 
Summary – Number of Times Suspended ............................92 
Support ..................................................................................2 
Suspension ..................................................................... 57, 64 
Suspension Considered Letter .............................................52 
Suspension Notice ................................................................60 
Suspension Notice for District Office ...................................63 
Suspension Status ................................................................93 
Suspensions - Statistical Overview .......................................90 
Suspensions Summary .........................................................88 
System Preferences .............................................................24 

U 

Unlocking the terminal ........................................................10 

W 

Withdrawal ..........................................................................65 

 
  



 
Integris Behaviour Training Notes 17-Jul-13 

Page 97 of 97 

© 2013 Civica Pty Ltd 
 

10 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education and Training. 
 
Contact details below: 

10.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 

10.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

10.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

11 Online Manuals and Training Notes 

11.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au. 
 
Select online manual login. 
Username: school 
Password: help 
 

11.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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